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GETTING STARTED WITH WORD

: : INFOcus

Microsoft Word is a word processing application that is usually part
of a suite of Microsoft applications, known as Microsoft Office.

You can use Word to create all sorts of documents, including
letters, reports, faxes, forms, emails, web pages, invitations and
certificates.

Before you leap into creating anything, it is worth taking some time
to become familiar with the Word window and its features.

In this session you will:

v/ gain an overview of the meaning and origins of word
processing

v/ gain an overview of the common types of documents that
can be word processed

gain an understanding of how to choose which word
processing software to use

learn how to start Word from the desktop

gain an understanding of the Word 2016 Start Screen
learn how to create a new blank document

gain an understanding of the Word 2016 screen
gain an understanding of how Word 2016 works
learn how to use the ribbon

gain an understanding of Backstage View in Word
learn how to use shortcut menus

gain an understanding of how dialog boxes work
gain an understanding of the Quick Access Toolbar
gain an understanding of the status bar

learn how to exit correctly and safely from Word.
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UNDERSTANDING WORD PROCESSING

Every facet of our everyday existence is chosen words. The ability to create these
controlled by the written word. We receive documents, to change them, to enhance the way
information, follow instructions and record events, they look, and to print them is what is now referred
often using documents that consist of carefully to as word processing.

Word Processing — A Definition

Word processing refers to the ability to create, edit and store text, and to reprint it as many times as
desired. Word processing is used to create a multitude of personal and business documents, such as
letters, memos, faxes, reports, books, essays, brochures, flyers, price lists, and the list goes on!

The Roots of Word Processing

The desire for humans to communicate in writing can be traced back to our cave dwelling ancestors who
painted images of hunting and everyday life on cave walls. Who knows, these might even have been the
first training manuals or reports on hunting expeditions!

The ancient Egyptians used writing to record commercial trading transactions. Initially using clay and
stone, they then invented writing on paper, or papyrus, to speed up the process of writing.

In 1492 Johannes Gutenberg invented the world’s first printing press which allowed one document to be
produced and disseminated many times. Many historians attribute world-shaking events such as the
English, French and American revolutions to the invention of printing and the communication of ideas.

The printing press marked the beginning of using machines to produce writing. This idea of using
machines for writing was kicked on in 1873 when Christopher Latham Scholes invented the first
commercially-practical typewriter. This typewriter was marketed by the Remington Arms company.
Earlier experimental typewriters used an alphabetical keyboard. However, the action of the type bars in
these machines was sluggish and the bars tended to jam. Scholes developed the QWERTY keyboard so
that letters used in combination were further apart, therefore allowing more time for the type bars to
return to their normal position and avoid jamming. In 1878 ten-finger typing was established using the
QWERTY keyboard — essentially, this has meant that the QWERTY keyboard has survived to this day
even on modern computers.

Typewriting gained enormous popularity in offices around the world in the first half of the twentieth
century. New office procedures and jobs were created around the typewriter — many organisations had
special typing pools, which consisted of teams of people (usually young women) typing documents.

In 1961 IBM introduced the Selectric typewriter. It was an electric typewriter with fewer moving parts
than a manual typewriter, and was much faster to use. In 1964 IBM released the Magnetic Tape
Selectric Typewriter that allowed typed information to be stored and retrieved. This machine was
marketed as a word processing machine because for the first time text could be stored, replayed (typed
automatically from the tape), changed and printed as many times as required.

In 1972 Lexitron and Linolex introduced the first modern word processing system which displayed
documents on a screen rather than on paper. This machine stored the documents on cassettes. The
screen allowed text to be entered, rearranged or deleted without the need for producing a paper copy.

In 1973 IBM released a new word processing machine that stored documents on floppy disk. Early
storage systems could hold only several pages. The floppy disk allowed the storage of large, multi-page
documents. The word processors were special machines designed specifically for producing documents.

In 1981 IBM released the IBM Personal Computer which used floppy disk storage technology. This was
one of the few machines ever invented in history that had no specific purpose. It soon became apparent
that the programs used in word processing machines could be stored on floppy disk. Once stored on
floppy disk they could be used in personal computers, thus converting the personal computer to a word
processing machine.

This concept has grown and is the underlying basis of modern word processing. Programs such as
WordStar, DisplayWrite, WordPerfect and later, Microsoft Word, emerged, allowing the personal
computer to produce documents with a size and complexity far greater than earlier machines. Today,
virtually all word processing is done on personal computers using word processing programs.
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TYPES OF WORD-PROCESSED DOCUMENTS

processing software to produce a much greater
variety of documents such as brochures,
newspapers and newsletters, greeting and
business cards, and more.

The first word-processed documents were
business documents such as letters, memos and
reports. With the development of screen and print
technologies, it is now possible to use word
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Type
Letters

Memos

Faxes

Reports

Briefing
Papers

Minutes

Essays and
Assignments

Training
Manuals

Books

Brochures

Newsletters

Flyers

Emails

Characteristics

Letters are usually one or two pages in length and consist
mostly of text

Memorandums are internal business documents that usually
consist of one or two pages of text

Faxes are documents transmitted over telephone lines. They
are usually brief and are used to convey information quickly and
succinctly. Faxes can be printed and sent from a fax machine or
they can be sent in electronic format directly from a computer
connected to a telephone line

Reports are normally multi-page documents providing
information or findings of an investigation or survey to the
reader. They usually consist of text. Long reports may also have
a table of contents and an index

Briefing papers are documents that provide background and
useful information regarding an historical or upcoming event

Minutes records what officially went on in a meeting. They can
be informal or formal and basically describe what was
discussed, what decisions were made, what actions need to be
taken, and who is responsible for carrying out those actions

Essays and assignments are normally multi-page documents
conveying ideas, opinions or research findings. They mostly
consist of text

Training manuals are normally multi-page documents designed
to instruct and inform. They range from mostly text to highly
structured documents. (Note: this publication was produced
using Microsoft Word)

Books are multi-page documents consisting mostly of text. They
have a table of contents and usually an index

Brochures are mostly laid out with graphics and text. They are
often no more than several pages in length. Increasingly, these
are transmitted electronically via the internet

Newsletters are used to convey news, updates and activities for
clubs, groups, organisations, products, and the like. They are
organised into columns and consist mostly of text

Flyers are normally one-page information sheets that are highly
graphical and structured advertising a product or event

Emails are usually short letters sent via the internet or through a
computer network

Intended Audience

Business associates,
customers, suppliers,
friends, relatives, etc

Fellow employees,
management,
subordinates

Business associates,
customers, suppliers

Business associates,
clients, management,
creditors, shareholders,
general public,
community groups, etc

Sales people, managers,
committee members,
company board
members, etc

Attendees and other
interested parties

Teachers, lecturers,
mentors

Course attendees,
people wishing to acquire
new skills and
knowledge, people
wishing to gain a
qualification or
accreditation

People seeking
information and/or
entertainment

Clients, potential
customers

Clients, customers,
general public, club
members, etc

Clients, potential
customers, club
members, etc

Anyone with an email
connection
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CHOOSING WORD PROCESSING SOFTWARE

Word processing software allows you to work other elements associated with text documents
with text in order to create documents. This such as tables. These days there are a range of
usually involves functions such as creating, software options for working with text and it's
formatting and deleting text and working with important to consider which one works best for you.

Microsoft Word

Microsoft Word is a word processing software program created by Microsoft and is part of a suite of
products known as Microsoft Office. It was originally launched in the early 1980s and today is one of;, if
not the most popular word processing software program as it contains a large variety of tools and
features for creating a variety of text-based documents. You can use Microsoft Word to create and save
text-based documents, spell check existing text, apply font formatting, insert pictures and much more.
While Microsoft Word is primarily used as a desktop application (meaning it is installed and run on your
desktop computer), Microsoft also provides Word Online and the Word mobile app. Word Online can be
accessed and used from the browser window of any device connected to the internet, while the Word
mobile app can be downloaded and used on any mobile device such as a mobile phone or a tablet.

Web Based Word Processing Apps
There are a number of different word processing apps that can be used online. For example;

Google Docs — Google Docs is used in conjunction with Google Drive which is Google’s cloud file
storage service. You can sign up for Google Drive for free and you will receive 15 GB of storage
allowance which is used across Google Drive, Gmail and Google Photos. If you require more storage
you can pay an annual or monthly fee to receive more storage. Google Docs is a free word processing
app available to use online or as a downloadable app on your mobile device. It is part of Google’s office
suite. If you wish to use Google Docs you must first sign up using a Gmail account. Once you have
signed up and signed in you are ready to start creating and working on documents. Google Docs
contains less advanced features and tools than Microsoft Word, however it does allow you to get Add-
ons which are apps that you can use in conjunction with the program in order to increase functionality.
For example, if you wish to add a table of contents, this functionality is not available in Google Docs but
if you get an add-on for creating a table of contents you can create and work with a table of contents in
Google Docs.

DropBox Paper - DropBox Paper is used in conjunction with DropBox, a cloud file storage service.
DropBox Paper has a much more minimal interface than Microsoft Word and Google Docs and has less
functionality for working with advanced word processing features. However, there is an emphasis on
working collaboratively and there are many tools for commenting and sharing your files. You can export
DropBox Paper files to a PDF so that you can open them in PDF viewers such as Acrobat or you can
export as a Microsoft Word file so that you can open and work on the file in Microsoft Word. You can
also import files of a range of different file types, including Microsoft Word.

Device Specific Word Processing Apps

Apple devices usually come with a word processing app that can only be used on Apple devices.
Currently, Apple Mac computers come with the TextEdit app which you can use for creating and editing
text files. If you are using an iPhone or iPad the Pages app may be included on your device by default.
You can use this app to convert existing text documents to other formats, create and edit HTML
documents and the like. Mobile android devices (any mobile device, laptop or desktop computer not
created by Apple) may also contain word processing apps by default. For example, Samsung phones
come with the Polaris office suite which can be used to work with Microsoft Word files among other file
types from the Microsoft suite.

Choosing The Right Software For You

Before you begin creating and working with text documents, it's important to decide which software
program is most appropriate for your needs. If you want to create a professional or long document it is
best to use a program like Microsoft Word that contains more advanced formatting and editing features.
If you want to create a short document that doesn’t require much formatting, a program like GoogleDocs
or DropBox Paper may be more suitable. If you don’t have access to a laptop or desktop computer, you
can use one of the many mobile text editing apps as discussed above. Remember that most text editing
software can be used in conjunction with each other. For example, you may begin creating a file in
DropBox paper before exporting it to Microsoft Word where you can use more advanced formatting and
editing features before importing it again to DropBox for sharing with others.
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STARTING WORD FROM THE DESKTOP

To create or edit a workbook, the first thing you apps list in the Start menu. You can then choose
must do is start Word. The first time you use to pin it to the Start menu or the taskbar so that
Word you will need to open it from the taskbar you can access it more quickly and easily the next
Search the web and Windows bar or the All time you use it.

a E Life at a glance

Try This Yourself:

Freelancer.com
chemphill, these Content Writing,

S o Before starting this exercise Excel and Articles projects and
8—E ensure the Computer |S contests might interest you
o switched on... Sl Mal
0 If there is no Word icon in the
taskbar at the bottom of the e
desktop, click on the Windows Microsoft Edge
icon in the taskbar, as shown, Cloudy
to display the Start menu 18° = )
14°
e Click on All apps to display a
o Canberra Phone Compa... ~ OneNote
list of all the apps on your
Computer Play and explore
e Scroll down to the W section -
Word 2016 is listed here... Sen (@ -
o Click on Word 2016 to start Sreretieiol] [mmEta |
Word :Er%:lwo Investigation into deaths of
e Right-click on the Word icon in vhknzzs | EhEEEOCRECRE
the taskbar to display a menu HEE B o
of options, as shown, then Bilscrings
select Pin this program to :
taskbar b
You can now click on this icon = Allapps

to open Word from the
desktop. This icon will remain
in the taskbar unless you
remove it...

I : ;
Search the web and Windows

wi Word 2016

-3 Pin this program to taskbar
Repeat step 5 to select Close ped

window to close Word X Close window

Click on the Word icon in the [
taskbar to open Word again —

For Your Reference... Handy to Know...
To add a Word icon to the desktop taskbar: e You can start Word by clicking in the taskbar
1. Display the Start menu, then click on All Search... bar, typing word, then clicking on
apps Word in the list of search results.
2. Right-click on Word 2016 e You can pin Word to the Start menu by

displaying the All apps list, right-clicking on

. Select Pi k X .
3. Select Pin to taskbar Word 2016 and selecting Pin to Start.
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UNDERSTANDING THE START SCREEN

Most times you open Word, a start screen will recently accessed files, open a document which
display. From this initial screen, you can choose has been saved to Computer or OneDrive or
what kind of document you want to work with. create a new document using the available

You can choose to work with one of your most templates.

Microsoft Word 2016 Start Screen

The Microsoft Word 2016 Start screen is very helpful if you want to quickly access files you have worked
on recently or create a new document based on one of the available templates (including the default
Blank document template).

If you have already worked on a document or several documents in Word, a list of recent files will display
below Recent in the blue pane to the left of the screen. If you haven’t worked on any documents yet, you
can still open existing documents by clicking on the link, Open Other Documents, located below
Recent. This lets you open an existing file from your computer or OneDrive.

The main pane of the start screen displays available templates you can use to create a new document
and a search box you can use to search the internet for additional templates. Templates are simply
layouts that have already been created which you can customise to suit your needs and then enter
relevant content. If you want to start with a clean slate you can choose the Blank document template —
you'll probably find this is the one you will use the most.

In the top right corner of the screen you'll see information about the account you've used to sign into
Windows as well as help, minimise, restore down, and close tools.

B - [m] x

Search for online templates o Ivana Robinson | P‘
or ivanarobinson@outlock.com |

Suggested searches:  Business  Persomal  Industry Print  Design Sets  Education  Event Switch account

Recent

FEATURED  PERSONAL

You haven't opened any documents recently. To
browse for a document, start by clicking an Open

Other Documents, C

[ Open Other Documents

Take a
tour

Blank document ‘Welcome to Word IF_Reference Sheet 2013

Aa Title Q TITLE -

The start screen will only display when you launch the Word 2016 application directly — that is, by
clicking on the Word tile on the Windows 10 Start screen, clicking on the application on the Apps
screen or under search results, or clicking on the taskbar icon if the application has been pinned to the
desktop Taskbar.

Word 2016 can also be started in Windows 10 by double-clicking on a Word document in File
Explorer. When this occurs Word 2016 will start with the document open on the screen and the start
screen shown above will be bypassed.
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CREATING A NEW BLANK DOCUMENT

When you want to create a letter, shopping list, template. A template defines the basic layout of a
annual report or anything with words in it for that document. To create a simple document, you are
matter, you will first need to create a document. able to base it on the Blank document template

All documents created in Word are based on a installed with Word.

= z . s Document] - Word

Try ThIS Yourself: Insert  Design  Layout  References Developer  ACROBAT Q0 Tell me what you want to do

2

Calibri (Body) - |11 -| A" A" Aa- AaBbCcDc| AaBbCcD: A3BhC¢ AaBbCcl

Before starting this T T T :
exercise you MUST Clipboard 5 Font 5 Paragraph ® styles

ensuretheMmrosoﬂ L |‘Z‘l-l-\‘g-l-l-\‘l‘l-J‘\‘4-\‘§‘|-§-|-7‘|-ﬂ-\‘9-|-10‘|-11‘|-12‘\‘l]-\‘14‘|-1§‘\‘a‘|-l
Word Start screen is 4

displayed...

TNormal | TNoSpac.. Headingl Heading 2

Open File

Click on Blank .
document (the first -

option beneath the .
title, Featured)

A new blank -
document will open. a
Notice that the

document is
automatically
assigned a
temporary name,
which is displayed in
the Title bar

For Your Reference... Handy to Know...
To create a Blank document: ¢ If you already have a document open and
1. Open Word so that the start screen is want to create a new one, click on the File
displayed tab to open Backstage view, click on the

9 @ik @n Blank dlesumen i e e New tab and then select Blank docume_nt.
templates e You can also use the keyboard shortcut ctr]
+ E to instantly open a new document
based on the Blank document template.
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THE WORD SCREEN

The Microsoft Word screen is made up of several
key components which are described on this page.

Some of these components, such as the ribbon
and Backstage view, are common to all other
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Office 2016 applications so once you know how they
work you won'’t have to relearn them when you use
other applications.

Docu.. = = |
c Insert Design Q Tellme Ivana Robinson (Q'_ Share
= N < A 2 5:-§:- . | == 3= o
M Calibri (Body) -[11 -/ A A | A3~ |, AaBbCcDc AaBbCeDe AaBbCe
_ B — — — =" - e
e Paste ., B I U -abeX, X Nk TNormal | TNoSpac.. Heading1 |- Editing
Clipboard = Font ] Paragraph [P Styles | —————
L |-2-|-1-|-g-l-1-|-2-|-3-|-4-|-5-|-6-|-?-|-3-|-9-|-10-|-11-|-12-|-13-|-14-|-15-|-é-|-1?-|-18- -
~
O 1
il -
1 »
e——Page1 of 1 Owords L[|# English [Australia) 5 E3| g - ] +

© ©¢ © 6 66 © ©

The File tab is used to access the Backstage view which contains file management functions, such as

saving, opening, closing, printing, sharing, and so on. There is also information contained here such as

your document Properties. Options are also available so that you can set your working preferences for
Word.

The ribbon is the tabbed band that appears across the top of the window. It is the control centre of
Word. You use the tabs on the ribbon to access the commands that are categorised into groups. The
commands include galleries of formatting options you can select from, such as the Styles gallery shown
above.

The Insertion point shows where the text will appear if you start typing.

The Mouse Pointer is used, amongst other things, to move the insertion point to different locations in the
document. It may appear as a pointer or an I-bar, as in this example, or any number of other forms,
depending upon its function at that position on the screen.

The Status bar appears across the bottom of the window and displays the current location of the
insertion point, page number and word count. You can access additional information such as Section
number, Column number, and so on, by right clicking on the Status bar.

Dialog box launchers are positioned in the bottom right corner of some groups of commands on the
ribbon. Clicking on a dialog box launcher opens a dialog box with additional options relating to that
group of commands.

The Scroll bar indicates your current position in the document and lets you move to other positions in
the document by clicking or dragging the bar. The arrows can also be used to move through the
document.

The View buttons and the Zoom slider are used to change the view and to increase or decrease the
zoom ratio for your document.
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How MICROSOFT WORD 2016 WORKS

The Word 2016 screen has three key areas. The or file, and changes to the file are controlled in
data you type is placed on a page. The data can be Backstage view. These key components are
manipulated using commands on the ribbon. The described on this page.

page is part of a larger entity known as a document

The Page

If you create a new blank document, it will | =
appear as a blank page in the document .
window with a blinking insertion point. When

you start typing, the text will appear at this »Bob Evans
location. You can also create a new
document from a template, such as this
resume shown to the right, where specific
information will appear by default on the
page, and you can edit it and add your own
data as desired.

[Type the objectives]

Th e RI b bO n [Type the degree] ([Type the completion dats])
b [Type list of accomplishments]
When you need to do something with the
data on a page, such as format it, colour [Type the job title] ([Type the start date] ~{Type the end date]
it, move it, copy it, and much more, you'll D e R | T e ey e

find all of the relevant commands on the
ribbon. The ribbon has the commands
organised thematically using a series of
tabs across the top.

Tabl 5 Document5 - Waord = -
Insert Design Layout References Mailings i Design Layout Q Tellme Ivana Robinson
-y - ind
& Gill Sans MT (E~ |10 ~| A" & Aa- | Bp pabceDe Asgbcene Aa Bl :: :::Im
------- MER= -

Pavste o B I U ~-abkex x° A~ W A T Header..  TNormal  Personal... Section |z [} Select -
Clipboard Font [F] Paragraph ] Styles [F] Editing e
Backstage View

When you want to do something with Inf
the data in your document, such as nro
save it so that you can access it again New
L . . Protect Document
later’ prlnt It, share it with a CO"eague’ Open » Control what types of changes people can make to this document.

Protect
Document =

send it to your boss, protect it from
prying eyes, or whatever, you will need
to access the Microsoft Office B B
Backstage view of Microsoft Word. Save s Adobe & P ST e e i TS
Backstage view is accessed using the Chreciefor
File tab on the ribbon. Rather than

displaying commands on a ribbon,
Backstage occupies the entire screen
and has a series of tabs down the left
side which allow you to perform a
number of operations. In our sample to
the right, the Print tab is active, and s
that is why you can see a preview of the Account Dosument”
document and a number of print-related @it

options on the screen.

Save

Save As

Document properties, content type information, template name and
author's name

Headers and footers

Custom XML data

Content that peaple with disabilities might find difficult to read

A setting that automatically removes properties and personal infarmation
when the file is saved

Allow this information to be saved in your file

—‘j Manage Document
Ql Checkin, check out, and recover unsaved changes.

7] There are no unsaved changes.

Feedback
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USING THE RIBBON

The ribbon is the command centre for Word. It
provides a series of commands organised into
groups that are placed on relevant tabs. Tabs
are activated by clicking on their name to display
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the command groups. Commands are activated by
clicking on a button, tool or gallery option.
Everything you could possibly want to do in Word
will be found somewhere on this ribbon.

q File Home Insert Design Layout References Mailings
Try This Yourself: .
’ = Calibri (Body) ~ 11 A A A bp | i LT .. | &
. . . alibn (Body) - - A a- — - iz~ -~ €=
Before starting this exercise, [
you MUST ensure that Word Paste B I U-scx.x A-¥-A-S=== (=
has started and a new Clipboard ra Font I Paragraph
document is displayed... = - : arap
L [ l-|-§-|-1|2|3|-4|-5-|-6-|
o Examine the groups on the
Home tab a
These are the most commonly
used commands... File Home Insert Design Layout References Mailings
e Click on the Insert tab 5 % F Erormart | s W
) 1/l Chart -
The commands on this tab are Pages Table Pictures Online Shaps & My Add-ins - Wikip

-

used to create pages, tables,
illustrations, comments,
headers and footers, text
objects and equations and to
add things such as apps and
media to your document...

Click on Shapes in the
Illustrations group to display

-

Tables

214 Screenshot -

-

Pictures
Il Recently Used Shapes
: lI\\.IZIOCJ.ﬂ"I_—L.EDGG
CITANR G I 4 ¢
Lines
NNSNTLL T RNG G
Rectangles
O [ L | o
Basic Shapes

(V| 6o

the Shapes gallery

This gallery includes a huge
range of shapes as well as the

menu option New Drawing
Canvas...

Click on each of the tabs and
examine the commands

Some of these open ‘dialog
boxes’...

On the View tab, click on
Zoom in the Zoom group to
open the Zoom dialog box

Click on [Cancel] then click on
the Home tab

Zoom ? *
Zoom to
O 2009 () Page width
O 100% () Text width
OIS% Oﬂhole page -
Percent: [100% =
Preview
AaBbCcDdEeXxYyZz
AaBbCcDdEeXxYyZz
AaBbCcDdEeXxYyZz
AaBbCcDdEeXxYyZz

For Your Reference...
To use the ribbon:
1. Click on a tab to display the commands

2. Click on a button to activate a command,
display a gallery or display a dialog box

Handy to Know...

Additional tabs known as Contextual tabs
appear in specific circumstances. For
example, if you insert a picture, the Picture
Tools: Format tab will appear. This provides
quick access to all of the tools you may need
to modify and work with the picture.
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The ribbon lets you work on the content in a
document so that you can add more content, format
it, insert pictures into it, copy it, and much more.
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UNDERSTANDING THE BACKSTAGE VIEW

The Backstage view, which is accessed using the in Backstage

File tab, lets you do something with the content you
create. You can save it for later use, print it on paper,
send it via email, and more by using the options found

The Backstage View

The File tab on the ribbon is not a normal tab — as you can tell by the fact that it is coloured. Clicking on the File tab
launches a mini-program within Microsoft Word known as Backstage view. Backstage, as it's known for short,
occupies the entire screen.
At the left of the Backstage is a navigation pane which is made up of tabs. These tabs provide you with access to
various operations, such as printing, saving and sharing. They can also provide you with information about your
document such as the file size.

Clicking on one of these tabs brings up a range of options associated with the particular operation.

The whole underlying purpose of Backstage is to let you protect your data, share it with others, and
provide you with valuable information about your document. Depending on what type of document it is
and what has been done to it, different information may display when the Info tab is selected.

Backstage Tabs
The Backstage tabs provide more options for working with a document

Info

New

Open

Save

Save As

Save as
Adobe PDF

History

Print

Share

Export

Close
Account

Options

Feedback

Provides status information about the current document and lets you
manage versions and permissions.

Lets you create a new document and provides access to a gallery of
inbuilt templates as well as ready access to a range of online
templates.

Provides a list of recent documents as well as the option to search
through your Computer, OneDrive or other place, to find what you
are looking for.

Saves your current document (if already saved to a location) or
prompts you to save to a location.

Allows you to name your document and save it to a location.

Allows you to save a Word document in the format of a PDF for
viewing in Word or PDF readers.

When this option is greyed out as in the example to the right, it is
unavailable. However when it appears white you can select it to view
the version history of the file you are working on.

Lets you print the current document and preview it.

Lets you share your document with other people via email, online
presentation, blog or Cloud (OneDrive).

Allows you to create a PDF/XPS document or change the file type of
your document.

Closes your current document.
Contains product and user information.

Presents you with a range of options which assist in the creation and
editing of your document.

Allows you to send feedback on Word to Microsoft.

Save

Save As

Sawve as Adobe
PDF

Account

Options

Feedback
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USING SHORTCUT MENUS

In addition to the ribbon, Word also features
shortcut menus that appear when you right-click
in an area on the screen or on an object. The
content of the menu will vary depending on

BSBITU211 - Produce Digital Text Documents

where you click. Shortcut menus provide an
alternative (and usually quicker) way to searching
through the ribbon to find a specific operation or
command.

Try This Yourself:

Before starting this exercise
ensure you have a blank
document open...

o Point to the middle of the
document and click with the
right mouse button to display
a shortcut or contextual
menu

Because you have clicked in
the body of the document, the
menu includes Font and
Paragraph options. As no text

Calibri (Body) ~ |11 V. e
alibri (Body) A A ,&.
B I U3~ A = 25 ~ Styles

hD Paste Options:

Y

O
Font...

Paragraph...

B 44 >

Smart Lockup

Synonyms »

farg)
7

Translate

Hyperlink...

e

Mew Comment

is actually selected the Cut,
Copy and Paste options are
greyed out as they are

unavailable...
e Click anywhere on the page
with the |eft mouse button to ™ P Customize Quick Access Toolbar... R
close the shortcut menu D Calibri (Body) ~ |11 Show Quick Access Toolbar Below the Ribbon 2l A

R=R ~ B I U ~akex, Customize the Ribbon... LS g 1

Point to any of the tabs on the -
ribbon Clipboard = Fa

L |-2-|-L-|-§-|-1-|-2-|-3-|-4-|-5-|-6-|-?-|-8-|-9-

Collapse the Ribbon I

Right-click on a tab to display
a shortcut menu

This menu differs from the
previous one and displays
toolbar and ribbon options
instead of text options. Word
has made an educated guess
about what you want to do
based upon what you have

clicked... °

e Click anywhere on the page
with the left mouse button to

el e 2

O S B S )

close the shortcut menu

For Your Reference... Handy to Know...

To display a shortcut menu: e Once a shortcut menu appears, the options

1. Point to the object or area of the screen on in it are selected by clicking on them with the
which you want to perform an operation left mouse button.

2. Right-click to display the shortcut menu
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